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Britannica 2003 Installation Guide

Welcome to Britanruca 2003

This booklet provides instructions for
installing and using the
Encyclop<edia Britannica 2003
Ultimate Reference Suite CD-ROM,
on Windows or Macintosh platforms.
Please follow the instructions
appropriate to your platform where
indicated.

Additional information and
assistance is provided in the
Britannica 2003 Help system. After
installing the product, access the Help
system from the program's menu bar
when YOll need more information.

System Requirements

Windows Requirements

• Microsof1® Windows® 98, 2000,
Windows Me, XP, or Windows NT®
4.0 with Service Pack 5

• Pentium I/® 266 MHz or faster
processor; 350 MHz recommended

• 128 MB RAM minimum; 256 MB
recommended

• 400 MB free hord-drive space

• CD or DVD drive

• 800 x 600 resolution, 16-bit colour

• Mouse or pointing device

• Sound cord and speakers
recommended

• Printer optional

• Internet access recommended

Trademarks are the praperty af their

respective owners.
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Macintosh Requirements

• Macintosh OS 10.1 or higher

• iMac ar G3 350 MHz or faster
processar

• 128 MB RAM physical memory
minimum; 256 MB recommended

• 400 MB free hard-drive space

• CD or DVD drive

• 800 x 600 resolution, millions of
colours

• Sound card and speakers
recommended

• Mouse or pointing device

• Pri nter optional

• Internet access recommended

Software Requirements
The following third-party components are
provided with the Britannica 2003 instal­
lation, and are installed only if they are

not found on your system:

• Sun Microsystems Java Runtimes

• QuickTime for Java

Installation Types
Britannica 2003 Ultimate Reference Suite
offers three installation choices. Choose

on installation type that will fit

comfortably on your hard drive and will
best suit your research needs.

Minimal

The Minimal setup installs the program
and 0 few data files on your hard drive.
While running Britannica 2003, you will

need 0 CD-ROM disc in your drive, and

you will need to switch discs, depending
on the application content you're using.
This setup requires 400 MB of free hard­

drive space.

Custom
The Custom installation type installs the

progrom and additional data components

of your choosing on your hard drive. The
following are the data components that
can be installed: Articles & Thumbnail

Images (approx. 650 MB), Images

(approx. 500 MB), Atlases (approx. 160
MB), and Multimedia (approx. 650 MB).
Depending on the which data

components you instoll, some disc
switching will be required.

Full

The Full setup installs the progrom and oll
data files on your hord drive. During the

installation, you will replace the
Installation Disc with data discs os

prompted until oll of the data is copied.
A Full setup allows you to run Britannica

2003 without using any discs after instal­
lation. This setup requires 2.4 GB of free
hard-drive space.

Note: More or less hard-drive space may
be required depending on your particular
system and hard drive. Be sure to leave

extra free space after the Britannica
2003 installation.

Before You Begin
1. Compare your system to the

System Requirements.

Windows: On your Desktop, right­

dick on My Computer and select

Properties. Check your operating
system version, system processor, and

amount of memory (RAM), then dose
the window.

Macintosh: From your desktop, open

the Apple Menu and choose About
This Mac. Make sure you are running

OS 10.1 or higher and that the

processor type and memory are
sufficient.

2. Make sure you have at least 400
MB of free space on your hard
drive.

Windows: Double-dick My Computer,
then right-click on the hard drive that

you plan to use for installation and
select Properties.

Macintosh: Control-dick (or right-dick)

on your Macintosh Hard Drive and
select Show Info.

Note: If you have additional free
space, you can choose to instoll more
data os described in Installation

Types above.
3. Check your Display Settings.

Windows: Choose Start on the

Windows Taskbar and select

Settings> Control Panel. Double-dick

the Display icon, then choose the
Settings tob. Make sure that your
screen area is set to 800x600 or

higher and that colour is set to 16-bit
colour or better.

Macintosh: Check your Monitors &
Sound Control Panel to make sure

that colours are set to millions and
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that resolution is set to 800x600 or
higher.

4. Uninstall previous versions of
Britannica software.

Windows: From the Control Panel,

double-dick on Add/Remove

Programs, select the Britannica
software, and dick Change/Remove.

Macintosh: Uninstall previous versions

of Britannica software by dragging
the folder to the trash.

5. Restart your computer.
6. Turn off virus-sconning software.

Follow the instructions provided by
the virus scanner manufacturer.

7. Close oll running tasks.

Windows: Right-dick on icons in your

System Tray (at the right side of the
Windows Taskbar at the bottom of

your Desktop) and select Close.

Macintosh: Use the "Dock" to

dose any running applications. These
will be denoted by the presence of a

small block triangle underneath the
icon.

Installing Britannica 2003
1. Startup: Load the Installation CD

into your CD/DVD drive.

Windows: If the Britannica 2003

setup program does not automatically
start, choose Start and Run from the
Windows Taskbar. Use the Browse

button to find and select Setup.exe
from the disCo

Macintosh: If the Britannica 2003

setup program does not automatically
start, double-dick on the Britannica

icon on your Desktop and choose
lnstoll Britannica.

2. Introduction: Click Next to continue.
3. Serial Number: Type the 16-digit

serial number provided on the back
of your disc jewel case. Click Next.

4. Readme: When you are prompted
to enter your serial number, the

Readme file will also be displayed.
This file contains notes about the
program, troubleshooting tips, etc.

You will be given the option to print
or dose the Readme file. Even if you
choose to dose the file, it will be
accessible later via the Britannica

2003 program folder.

5. Choose Install Folder: Accept the
default Iocation by dicking Next. Or,
dick Choose to select 0 different

lacation.

J

6. Choose Product Features:
Choose one of the three Installation

Types described previously and dick
Next.

7. Pre-Installatian Summary: Verify

that the information displayed is
correct. Click Next.

8. Installation: Wait os Britannica
2003 files are instalied. If you chose

the Full or Custom installation, you
will be prompted to replace the

Installation Disc in your CD-ROM
drive with the data discs. When

prompted again, return the
Installation Disc to the CD-ROM drive

and complete the setup.
Note: A Full installation may take up
to 45 minutes to finish.

9. Finish: If you are prompted to restart
your computer, select Yes and dick
Finish. If the Readme checkbox is

marked, the Readme file is displayed
when the setup is finished. To print
the Readme, open its File menu and

choose Print; to dose the Readme,

dick the [xl button in the corner of the
window.

1O_After installing Britannica 2003,

please remove and safely store the
Installation and Data Discs.

11. When the program starts for the

first time, be sure to Register your
product and download any available

Content Updates.
Note: If you cancel the installation

procedure at any time, some files
may be left on your system. You must
remove these files if you wish to

reinstall the application. Please see
the next section for more information.

Uninstalling Britannica 2003
Uninstalling Britannica 2003 will allow

you to completely remove the application

from your computer. You may do this if
you no longer plan on using the
program, or if a previous installation
attempt failed.

Windows: From the Britannica folder on

the Start Menu, dick on Uninstall. If there
is no Uninstall icon, then you may need
to manually remove the Britannica 2003

folder from your Program Files directory.
Click Start and Run from the Windows

Taskbar and type 'explare'. When
Windows Explorer loads, open the

Program Files folder and drag Britannica
2003 to the Recyde Bin on your

Desktop.
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Macintosh: Open your Macintosh HD and
drag the Britannica 2003 lolder ta the

Trash an your desktop.

Note: II you wish to keep any projects or
notes that you have creoted in the Research
Organiser, you will need to copy the

Research lolder to another leeation. When
the program is installed, the Reseorch lolder

is leeated inside 01 the existing Britannica

2003 program lalder.

Registration
It is recommended that you register online
lollawing the installation procedure;

hawever, you can register at any time.
Registration gives yau access ta updates

and special olfers.

To register online:
1. Cannect to the Internet.

2. Open the File menu and select Register.
3. Select the Register Online option lram

the menu. A separate Web browser
windaw opens to the Britannica

product registration page.
4. Complete and submit the online

registration lorm.

To register by post:
1. Connect 0 printer to your computer

and turn it on.
2. Open the File menu and select

Register.
3. Select the Register by Mail option

lrom the menu. A registration lorm
will print.

4. Fill in the printed lorm and post it to
the address provided on the lorm.

Start Britannica 2003
1. Remove the Installation Disc and store

it salely lor luture use.
2. Insert the apprapriate Britannica

2003 data disc, il necessary:
II you have 0 Minimal ar Custam

installation, insert the appropriate data
disc in your CD/DVD-ROM drive.
II you have 0 Full installation, yau
don't need any 01 the discs in your CD­

ROM drive to run the program.
3. Double-click the Britannica 2003 icon

on your Desktop. An intraductory
panel appears. Wait while the

program loads. For more help, reler to
the Britannica 2003 Quick Start guide

or to the Help system within the

program.

Updating
You can download new orticles and

program updates periodically Iram the

Internet. Updates keep yaur Libraries
current by providing new and revised
articles. Yau must be connected to the

Internet to receive updates.

To check for updates:
1. Connect to the Internet.

2. Make sure you have registered
Britannica 2003.

3. Click the Free Encyclopedia Updates!
link on the Welcome Screen, or open

the Tools menu and select Update
Center.

4. Your Web browser opens the

Britannica Technical Support site,
where yau can download the lotest

updates.
5. Look lor 0 download link lor

Encyclop~diaBritannica 2003
Uftimate Reference Suite designated

lor your computer platlorm.

To download updates:

An update may include program
enhoncements or new content lor one or
more 01 your Libraries. The size and

approximate down load time 01 each

update packet is noted on the Updates

page.
1. Click the link to download the

update. Save it to 0 location that you

can easily lind on your hard drive.
2. Close yaur Britannica 2003 pragram,

then double-click the downloaded lile
to run the update program.

3. Restart Britannica 2003. Program
enhancements, updated articles, and
new articles are now included.

Questions
Q 00 I have to be connected to the

Internet to use Britannica 2003?
A No, Britannica 2003 provides 0

complete relerence set lar your

personal computer. Hawever, you will
not be able to use the Online Content
button in the Search Results to link to
related Web sites, magazine articles,

and video unless you hove on Internet
connection.

Q Where can f get more help?
A The Help system accessible lrom the

program's menu bar explains in more

depth how things work. II you are still
having technical dilficulties, con/act

Britannica Customer Support.
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Customer Support
If your questions are not answered by the

supplied documentation or Help system,
contact Britannica Customer Support.

• Check the Technical Support Web site
http://cdsupport.britannica.co.uk for
online technical support.

• Email us at support@britannica.co.uk

• Cailusat09067510101 from
within the United Kingdom, or
+44 1179760260 from outside the

United Kingdom, Monday - Friday
from 10.30am to 4.30pm UK time.

Please note: Calls are charged at

75p per minute (British Telecom rate)
calls from mobiles and payphones
may cost more.

o

In order for Britannica Customer Support

to assist you better, please be prepared
to provide the following information:

• Your name.

• Your address and email address.

• Your serial number, which can be
found on the back of your jewel case
(this identifies your product).

• Include any error messages and the
steps taken to reproduce them.

• Information about your computer:
Type of operating system (example,
Windows 98)

Processor speed (example, 500 MHz)
Ämount of memory
Ämount free hord disk space (for

example, 4Gb)
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